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Chapter 1
Introduction

How this Guide is Organized

This guide describes how to identify and operate the key features of the 
hardware components of the StorNext M660.

Guide Contents This guide contains the following chapters:

• Chapter 1, Introduction – provides an overview of this guide, and 
also includes document conventions, product safety statements, a 
list of related documents, and supported Internet browsers.

• Chapter 2, Hardware Overview – provides an overview of the 
StorNext M660.

• Chapter 3, Basic System Operations – provides basic operating 
instructions for the StorNext M660system.

• Chapter 4, Contacting Quantum – provides contact information for 
the Quantum Technical Assistance Center.
StorNext M660 Metadata Appliance  Hardware Guide 1
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Navigating This Document With Adobe Reader
Chapter Contents • Navigating This Document With Adobe Reader on page 2 – explains 
how to navigate this document with Adobe Reader.

• About the StorNext M660 Hardware on page 4 – provides an 
overview of the system hardware components.

• Supported Internet Browsers on page 10 – provides the location 
where the supported Internet Browsers list is located.

• Document Conventions on page 7 – provides information about the 
conventions used in the document.

• Product Safety Statements on page 10 – provides multi-lingual 
safety and regulatory statements.

Navigating This Document With Adobe Reader

How to Navigate this PDF

Have you ever clicked on a link, or a bookmark in a PDF and then needed 
to go back to the place you were before you clicked? You might have 
thought that the link you clicked stranded you somewhere in the 
document without a way to get back. Actually, Adobe Reader provides a 
number of ways to navigate backward and forward within a PDF that 
you might find useful:

Navigate using the keyboard shortcuts (Windows)

• <Alt> + <left arrow key> to navigate backward

• <Alt> + <right arrow key> to navigate forward

Navigate using the keyboard shortcuts (Mac)

• <Command> + <left arrow key> to navigate backward

• <Command> + <right arrow key> to navigate forward
2 StorNext M660 Metadata Appliance  Hardware Guide
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Enable “Previous View” and “Next View” navigation buttons

Note: The steps enable these buttons in Acrobat XI. The steps you use 
may be different for older versions of Reader. Refer to the 
Adobe Reader help if needed.

1 Open Adobe Reader.

2 Go to View > Show/Hide > Toolbar Items > Page Navigation and 
click “Previous View”.

3 Go to View > Show/Hide > Toolbar Items > Page Navigation and 
click “Next View”.

The Previous and Next View buttons are now shown:

Note: If your Reader window is scaled too small horizontally, the 
items on the “toobars” can become hidden, including the 
options you just enabled. If this happens, just scale your 
window width until the hidden buttons are displayed.

Navigate using Right-click options

• <Right click> + Previous View to navigate backward

• <Right click> + Next View to navigate forward

Navigate using View menu options

• View > Page Navigation > Previous View to navigate 
backward

• View > Page Navigation > Next View to navigate forward
StorNext M660 Metadata Appliance  Hardware Guide 3
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About the StorNext M660 Hardware
About the StorNext M660 Hardware

About the StorNext 
M660 Metadata 
Appliance

The StorNext M660 Metadata Appliance offers the powerful file-sharing 
capabilities of StorNext in an optimized appliance package. The 
StorNext M660 comes with a pair of metadata controller (MDCs) nodes 
in a High Availability (HA) configuration and a high-performance 
metadata array. An optional metadata disk expansion unit adds another 
metadata array to the system for additional file systems, performance 
and capacity. The appliance comes in four models: the StorNext M661 
and M662 and the StorNext M661XL and M662XL.

Note: At times this guide uses StorNext M660 as a generic term that 
applies to the StorNext M661 and M661XL and the StorNext 
M662 and M662XL models. When information pertains to a 
specific StorNext M660 model only, those differences are 
noted.

MDCs coordinate SAN file access across clients. Additionally, the 
standby node can be used as a distributed data mover (DDM) host using 
the included license, or both MDC nodes can be used as LAN client 
gateways in non-Lattus systems.

During installation, the StorNext M660 can be configured for use in 
different storage environments - in StorNext environments operating as 
a StorNext Metadata Controller (MDC) High Availability (HA) pair with 
access to both disk and tape libraries, or as a StorNext MDC HA pair 
with access to disk, tape, and Lattus storage.

Note: Access to Lattus storage is available on M662 and M662XL 
Metadata Appliances only.

Note: Content in this document applies to both Lattus and non-
Lattus systems unless otherwise noted.

Hardware Specification Each StorNext M660 MDC node contains the following:
4 StorNext M660 Metadata Appliance  Hardware Guide
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• Two redundant, hot-swappable system hard drives in a RAID 1 
configuration

• Redundant cooling fans and power

Network Connectivity Here are the quantity and type of network ports available on the 
different system models:

• All StorNext M660 models feature one 4-port 8 Gb FC card for SAN 
network connectivity.

• The StorNext M661 and M661XL feature 11 configurable 1GbE 
Ethernet ports per node.

• The StorNext M662 and M662XL feature two 10 GbE and seven 1 
GbE configurable Ethernet ports per node.

 
 MDCs coordinate SAN file access across SAN clients. Additionally, the 
standby node can be used as a distributed data mover (DDM) host. Both 
MDC nodes can be used as StorNext gateways (in non-Lattus systems 
only).

Base System and 
Expansion Unit 
Description

The StorNext M660 comes configured as a Base System with two 
Metadata Controller (MDC) nodes which share a common file system 
located on a single metadata array for storage. 

The StorNext M660 can also come configured as a Base System with an 
Expansion Unit, or the Expansion Unit can be added to the system in the 
field. The Expansion Unit adds an additional metadata array disks to the 
system.

The different M660 models support different numbers of file systems, as 
described here:

• In M661 and M662 systems: the base system supports up to four 
file systems. The base system with the optional expansion unit 
supports up to eight file systems.

• In M661XL and M662XL systems: The base system supports up to 
eight file systems. The base system with the optional expansion unit 
supports up to 16 file systems.
StorNext M660 Metadata Appliance  Hardware Guide 5
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StorNext M660 
Gateway Licensing

There are several items to note about the Gateway Appliance license 
used on the StorNext M662 or M662XL Metadata Appliance with 
Gateway functionality enabled:

• The StorNext StorNext M662 or M662XL Metadata Appliance with 
Gateway functionality enabled has a “per Gateway” DLC license 
model. This license allows you to add clients without having to 
purchase additional individual licenses.

• For new customers with no existing StorNext components, the 
license comes from the factory pre-installed, but must first be 
enabled for use on StorNext M662 or M662XL Metadata Appliances.

Note: Do not enable gateway functionality for StorNext M662 and 
M662XL Metadata Appliances connected to Lattus systems. 
While there are no functional issues in enabling the LAN 
gateway functionality within a Lattus environment, observed 
throughput when moving data to Lattus through the 10GbE 
ports will be slower than expected if this feature is enabled.

• If you choose to install the StorNext M662 or M662XL Metadata 
Appliance with Gateway functionality enabled into the same 
StorNext network as a customer-configured DLC gateway, you will 
be limited to the existing DLC client license count.

• To determine whether the Gateway license is enabled, look for a 
green check next to the Gateway Licensed MDClicense on the 
License page in the GUI of the M662 or M662XL Metadata 
Appliance.

About StorNext M660 
Licensing

Separate licenses are required for various StorNext features, as well as to 
perform an upgrade to a new release. Refer to the current StorNext 
Licensing Guide for a description of the types of licenses and procedures 
for obtaining them.

About StorNext 
Features

This guide includes information about StorNext features that may not 
initially apply to your StorNext M660, but that could be pertinent in the 
future. 
6 StorNext M660 Metadata Appliance  Hardware Guide
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The initial offering of the StorNext M660 is not designed for 
deduplication, and the standard StorNext deduplication license is not 
supported with the StorNext M660.

Notes, Cautions, and 
Warnings

The following describes important information about Notes, Cautions, 
and Warnings used throughout this guide.

Note

Note: Emphasizes important information related to the main topic.

Consequences if not followed:

There are no hazardous or damaging consequences.

Caution

Caution: Indicates potential hazards to equipment or data.

Consequences if not followed:

Failure to take or avoid this action could result in loss of data or 
harm to equipment.

Warning

WARNING: Indicates potential hazards to personal safety.

Consequences if not followed:

Failure to take or avoid this action could result in physical harm to 
the user or hardware.

Document Conventions This guide uses the following document conventions to help you 
recognize different types of information.
StorNext M660 Metadata Appliance  Hardware Guide 7



Chapter 1: Introduction
About the StorNext M660 Hardware
When a step includes substantial supporting information, the following 
document conventions are used to differentiate the supporting 
information from the procedural content:

Hardware Conventions

Software Conventions

Conventions

Right side of the system — Refers to the right side as you face the 
component being described.

Left side of the system — Refers to the left side as you face the 
component being described.

Conventions Examples

For all UNIX-based 
commands, the # prompt is 
implied, although it is not 
shown.

TSM_control stop 
is the same as 
# TSM_control stop

For all UNIX-based 
commands, words in italic 
are variables and should be 
replaced with user-defined 
values.

cvaffinity filename
where filename is a variable 
and should be replaced with 
a user-defined value.

User input is shown in bold 
font.

./install.stornext

Computer output and 
command line examples are 
shown in monospace font.

./install.stornext

User input variables are 
enclosed in angle brackets.

http://<ip_address>/cgi-
bin/stats
8 StorNext M660 Metadata Appliance  Hardware Guide
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For UNIX and Linux 
commands, the command 
prompt is implied.

TSM_control stop
is the same as 
# TSM_control stop

File and directory names, 
menu commands, button 
names, and window names 
are shown in bold font.

/data/upload

Menu names separated by 
arrows indicate a sequence 
of menus to be navigated.

Utilities > Firmware

Conventions Examples
StorNext M660 Metadata Appliance  Hardware Guide 9
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StorNext M660 
Documents

A complete list of documentation for the StorNext M660 Metadata 
Appliance is located on the following web page:

http://www.quantum.com/snmdcdocs/

Supported Internet Browsers

The Internet browser software is not supplied with the StorNext M660; 
you must obtain and install it independently. Refer to the Quantum 
StorNext Compatibility Guide for the complete list of browsers 
supported by StorNext.

Product Safety Statements

Quantum will not be held liable for damage arising from unauthorized 
use of the product. The user assumes all risk in this aspect.

This unit is engineered and manufactured to meet all safety and 
regulatory requirements. Be aware that improper use may result in 
bodily injury, damage to the equipment, or interference with other 
equipment.

WARNING: Before operating this product, read all instructions and 
warnings in this document and in the system, safety, and 
regulatory guide.
10 StorNext M660 Metadata Appliance  Hardware Guide
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Chapter 2
Hardware Overview

This chapter contains the following sections:

• StorNext M660 Components

• StorNext M660 Connectivity on page 35

• Relocating the StorNext M660 System on page 51

StorNext M660 Components

The StorNext M660 Metadata Appliance consists of the following 
components:

• StorNext M660 MDC Nodes

• StorNext M660 Metadata Array
StorNext M660 Metadata Appliance  Hardware Guide 13
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StorNext M660 Components
Figure 1 shows the StorNext M660 Base System with optional expansion 
unit.

Figure 1  StorNext M660 Base 
System Components (Front)

StorNext M660 MDC 
Nodes

The two StorNext M660 MDC Nodes are servers that provide storage 
and control for the StorNext M660 platform software (host OS and 
StorNext software). The MDC Nodes contain redundant hard drives in a 
RAID 1 configuration, ensuring high availability of the system software.

 

14 StorNext M660 Metadata Appliance  Hardware Guide
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MDC Node -  Front View

Figure 2 shows, and Table 1 describes the indicators and buttons on the 
front of the StorNext M660 MDC Node.

Figure 2  StorNext M660 MDC 
Node – Front View

Table 1  StorNext M660 MDC 
Node – Front View Indicators 
and Buttons

StorNext
Platform Software

Empty Drive Slots

Item

Indicators, 
Button, or 
Connector Icon Description

1 Power-on indicator/ 
power button

The power-on indicator lights when the system power is on.
The power button controls the power supply output to the 
system. When the system bezel is installed, the power button 
is not accessible. 
Note: To perform a graceful shutdown, press and release 

the power button.
Note: To force an ungraceful/hard stop shutdown, press and 

hold the power button for 5 seconds.
StorNext M660 Metadata Appliance  Hardware Guide 15
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MDC Node - Hard Drive Indicator Patterns

The two hard drives located on the front of each MDC Node (in drive 
bays 0 and 1) are used to store the (operating system and StorNext 
software). Drive bays 2 through 7 are empty, and reserved for Quantum 
use. Unlabeled indicators, connectors, and buttons are reserved for 
Quantum Service.

For more information, see MDC Node - Hard Drive Indicator Patterns on 
page 16.

2 System 
identification 
button

The identification buttons on the front and back panels can 
be used to locate a particular system within a rack. 
When one of these buttons is pushed, the LCD panel on the 
front and the blue system status indicator on the back blink 
until one of the buttons is pushed again.

3 LCD menu buttons Allows you to navigate the control panel LCD menu

4 LCD panel Provides system ID, status information, and system error 
messages
The LCD lights blue during normal system operation. When 
the system needs attention, the LCD color will change to 
amber, and will display an error code followed by descriptive 
text.
Note: If the system is connected to AC power and an error 

has been detected, the LCD lights amber, 
regardless of whether the system has been powered 
on.

USB connectors (2) To connect USB devices to the system (USB 2.0 compliant)

System service tag 
pull tab

A slide-out tab which contains system information including 
the Express Service tag number, embedded NIC MAC address, 
and iDRAC Enterprise card MAC address

Optical drive SATA optical DVD drive

Item

Indicators, 
Button, or 
Connector Icon Description
16 StorNext M660 Metadata Appliance  Hardware Guide
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Figure 3  StorNext M660 MDC 
Node – Hard-Drive Indicator 
Patterns

1 Hard-drive activity indicator (green)

2 Hard-drive status indicator (green or amber)

Table 2  StorNext M660 MDC 
Node – Hard-Drive Activity and 
Status Indicators

1

2

Drive-Status Indicator Pattern 
(RAID Only) Condition

Blinks green two times per second Identify drive/preparing for removal.

Off Drive ready for insertion or removal.
Note: When system power is applied, the drive status 

indicator remains off until all hard drives are 
initialized. Drives are not ready for insertion or 
removal during this time.

Blinks green, amber, and off Predicted drive failure.

Blinks amber four times per second Drive failed

Blinks green slowly Drive rebuilding

Steady green Drive online
StorNext M660 Metadata Appliance  Hardware Guide 17
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MDC Node - Rear View

The back of each StorNext M660 MDC Node has a series of indicators, 
connectors, and buttons. Unlabeled indicators, connectors, and buttons 
are reserved for Quantum Service.

Figure 4 shows the rear indicators, connectors, and buttons of the 
system.

Figure 4  StorNext M661 and 
M661XL MDC Node – Rear 
View

Figure 5 shows the rear indicators, connectors and buttons of each 
StorNext M662 and M662XL MDC node. See Table 3 for information on 
the labeled components.

Blinks green three seconds, amber 
three seconds, and off six seconds

Rebuild aborted

Drive-Status Indicator Pattern 
(RAID Only) Condition
18 StorNext M660 Metadata Appliance  Hardware Guide
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Figure 5   StorNext M662 and 
M662XL MDC Node – Rear 
View

See Table 3 for information on the labeled components.

Table 3  StorNext M660 MDC 
Node – Rear Panel Features and 
Indicators

Item
Indicator, Connector 
and Button Icon Description

1 PCIe slot 1 M661M661 and M661XL: 4-port 1 GbE Ethernet HBA
M662 and M662XL: 2-port 10 GbE Ethernet HBA

2 PCIe slot 2 6-port 1 GbE Ethernet HBA

3 PCIe slot 3 4-port 8Gb FC HBA

4 PCIe slot 4 2-port 6Gb SAS HBA

5 iDRACport IDRAC Reserved for Quantum Service

6 Ethernet Service port Reserved for Quantum Service

7 Ethernet Port 2 
connector

Integrated 1GbE (Customer-Facing) DLC or 
management

8 USB Port 1 and 2  USB Ports
StorNext M660 Metadata Appliance  Hardware Guide 19
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9 Power supply 2 (PS2) Secondary Power Supply

10 Power supply 1 (PS1) Primary Power Supply

Item
Indicator, Connector 
and Button Icon Description
20 StorNext M660 Metadata Appliance  Hardware Guide
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MDC Node – NIC Indicator Codes

Figure 6 shows the StorNext M660 MDC Node NIC indicator codes.

Figure 6  MDC Node – NIC 
Indicators 

1 Link indicator

2 Activity indicator

1 2

Indicator Status Indicator Code

Link and activity indicators are off. The NIC is not connected to the network.

Link indicator is green. The NIC is connected to a valid network link at 1000 Mbps.

Link indicator is amber. The NIC is connected to a valid network link at less than the 
maximum port speed.

Activity indicator is blinking green. Network data is being sent or received.
StorNext M660 Metadata Appliance  Hardware Guide 21
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MDC Node – Power Supply Indicator Codes

This section describes the StorNext M660 MDC Node power supply 
indicator codes (see Figure 7). The power supply indicators show if 
power is present, or if a power fault has occurred.

Figure 7  MDC Node - Power 
Supply Indicator

Table 4  Power Supply Status 
Indicator

Indicator Status Indicator Code

Not lit AC power is not connected.

Green The handle displays green which indicates that a valid power 
source is connected to the power supply and that the power 
supply is operational.
When the system is on, a green light also indicates that the 
power supply is providing DC power to the system.
22 StorNext M660 Metadata Appliance  Hardware Guide
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Caution: When correcting a power supply mismatch, replace only 
the power supply with the flashing indicator. Swapping the 
opposite power supply to make a matched pair can result 
in an error condition and unexpected system shutdown. To 
change from a High Output configuration to a Low Output 
configuration or vice versa, you must power down the 
system.

Caution: The AC power supplies, which come with the system, 
support both 220 V and 110 V input voltages. When two 
identical power supplies receive different input voltages, 
they can output different wattages, and trigger a 
mismatch.

Caution: Combining AC and DC power supplies is not supported and 
triggers a mismatch.

Note: Each AC power supply has an illuminated translucent handle 
that serves as an indicator to show whether power is present or 
whether a power fault has occurred.

StorNext M660 
Metadata Array

The StorNext M660 features the following Metadata Arrays:

• StorNext M660 Metadata Array on page 24

• StorNext M660 Metadata Expansion Unit on page 32

Flashing Amber Indicates a problem with the power supply.

Flashing green When hot-adding a power supply, this indicates that the 
power supply is mismatched with the other power supply (a 
high-output power supply and an energy smart power supply 
are installed in the same system). Replace the power supply 
that has the flashing indicator with a power supply that 
matches the capacity of the other installed power supply.

Indicator Status Indicator Code
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StorNext M660 Metadata Array

The StorNext M660 Metadata Array features a fully- 24-drive 2U storage 
enclosure. The first two drives are global hot spares. The next six are 
configured into three 1+1 RAID-1 mirrors. These mirrored sets are split 
into two stripe groups (SGs): SG0 combines three LUNs into the 
metadata and journal for the shared file system. SG1 combines three 
LUNs into the shared HA file system, and includes the StorNext Storage 
Manager database.

The Metadata Array also contains redundant power supplies and dual 
Tahoe or Snowmass controllers. Each Tahoe controller provides two 12 
Gb Serial Attached SCSI (SAS) host ports. Each Snowmass controller 
provides two 6 Gb Serial Attached SCSI (SAS) host ports. StorNext 
Metadata Arrays connect to StorNext MDC nodes via 6 Gb SAS.

Additional storage can be added to the Metadata Array by purchasing 
an expansion kit.

Hard drives are supplied in hot-swappable drive carriers that fit in the 
hard-drive bays.

The StorNext M660 Metadata Array has a series of indicators and 
buttons located on the front and back of the array:

• Metadata Array – Front View on page 25

• Metadata Array – Rear View on page 27

Note: There are two generations of Metadata Array controller 
currently in use. While both generations of the controller use 
the same SAS connection order, from left to right, different 
cables are used for the connections. The Tahoe controller is 
connected with a cable containing both a 12Gb SAS (square) 
connection, which is attached to the Tahoe controller, and a 
6Gb SAS (rectangular) connection, which is attached to the 
MDC nodes and the Expansion Unit (if used). The previous 
generation Snowmass Controller cable contains 6Gb 
connections on both ends. Use the appropriate SAS cables for 
the controllers in your Metadata Array.
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Caution: Do not mix and match different generation controllers. Use 
only Tahoe controllers in systems which originally 
contained Tahoe controllers, and use only Snowmass 
controllers in systems which originally contained 
Snowmass controllers.

Metadata Array – Front View

The front of the StorNext M660 Metadata Array contains the left end 
cap, which contains the drive tray LEDs; the right end cap; and the 
drives (see Figure 8).

Figure 8  StorNext M660 
Metadata Array – Front View

Metadata Array – Front LEDs

The front of the StorNext M660 Metadata Array contains the left end 
cap, which contains the drive tray LEDs (see Figure 9).

Global
Hot Spares

3 x 1+1
RAID 1

8 x 1+1
RAID 1
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Figure 9  Metadata Array Front 
LEDs

Item Icon LED Description Color On Off

1 Drive Tray Locate White Identifies a drive tray 
that you are trying to 
find.

Normal status

2 Service Action 
Required

Amber A component within 
the drive tray needs 
attention.

Normal status

3 Drive Enclosure Over-
Temperature

Amber The temperature of 
the drive tray has 
reached an unsafe 
level.

Normal status

4
 

Power Green Power is present. Power is not present.

5 Standby Power Green The drive tray is in 
Standby Power 
mode.

The drive tray is not 
in Standby Power 
mode.
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Metadata Array – Rear View

The StorNext M660 Metadata Array contains dual controller canisters 
for host connectivity and redundancy (see Figure 10).

Determining the 
Controller Used in the 
Array

Two controllers are currently used in StorNext M660 Metadata Arrays, 
the Snowmass Controller, and the Tahoe controller.

Here are a few simple ways you can identify the Tahoe controller from 
the Snowmass Controller:

Port 1 Port 2

ID/
Diag

|O|O|

Port 1 Port 2

ID/Diag

Lnk Lnk

Tahoe Controller

Snowmass Controller

1 2 3 4 5

Item Description Found in Controller

1 Serial Port Snowmass-only
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Figure 10  Metadata Array – 
Rear View Canister Locations

There are numerous connectors, displays and LEDs on the back of the 
Metadata Array controller (see Figure 11 and Figure 12). Unlabeled 
connectors are reserved for Quantum Service.

2 12 Gb SAS Port (square) Tahoe-only

6 Gb SAS Port (rectangle) Snowmass-only

3 USB Connection Tahoe-only

4 Mini USB Tahoe-only

5 12 Gb SAS Port (square) Tahoe-only

6 Gb SAS Port (rectangle) Snowmass-only

Item Description Found in Controller

Port 1 Port 2 |O|O| Port 1 Port 2

D

|O|O|

ID//
Diag

ID//
Diag
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Figure 11  Rear Features and 
Indicators - Metadata Array 
with Tahoe Controllers

Figure 12  Rear Features and 
Indicators - Metadata Array 
with Snowmass Controllers

Table 5  Rear Features and 
Indicators - Metadata Array 
Controllers

Port 1 Port 2

ID/
Diag

|O|O|

1 2 3 4 5 6 7

8 9 10 11 12 13

Port 1 Port 2

ID/Diag

Lnk Lnk

1 2 3 4 5 6 7

8 9 10 11 12 13

Item Description

1 Host Fault LED

2 Host Active LED

3 Host Port SAS Connector 1 
(12 Gb - Tahoe Controller, 6 Gb - Snowmass Controller)
StorNext M660 Metadata Appliance  Hardware Guide 29



Chapter 2: Hardware Overview
StorNext M660 Components
Metadata Array — General LED Behavior

For more information about the Metadata Array LED locations and 
general behavior, see Table 6.

Table 6  Metadata Array – LED 
Locations and Behavior

4 Host Port SAS Connector 2 
(12 Gb - Tahoe Controller, 6 Gb - Snowmass Controller)

5 Expansion Fault LED

6 Expansion Active LED

7 Expansion Port SAS Connector 
(12 Gb - Tahoe Controller, 6 Gb - Snowmass Controller)

8 Battery Service Action Required LED

9 Battery Charging LED

10 Controller Service Action Allowed LED

11 Controller Service Action Required LED

12 Cache Active LED

13 Seven-Segment Displays

Item Description

LED Icon Location General Behavior

Power
 

• Drive enclosure
• Controller
• Power Supply/Cooling Fans

On – Power is applied to the drive tray 
or the canister.
Off – Power is not applied to the drive 
tray or the canister.

Locate • Front bezel on the drive tray On or blinking – Indicates the drive 
tray that you are trying to find.
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Over-
Temperature

• Front bezel on the drive tray On – The temperature of the drive tray 
has reached an unsafe condition.
Off – The temperature of the drive tray 
is within operational range.

Standby 
Power

• Front bezel on the drive tray On – The drive tray is in Standby mode, 
and the main DC power is off.
Off – The drive tray is not in Standby 
mode, and the main DC power is on.

Service 
Action 
Allowed

• Controller canister
• Power-fan canister
• Drive

On – It is safe to remove the Controller 
canister, the power-fan canister, or the 
drive.
Off – Do not remove the Controller 
canister, the power-fan canister, or the 
drive.
Note: The drive has an LED, but no 

symbol.

Service 
Action 
Required 
(Fault)

• Controller canister
• Power-fan canister
• Drive

On – When the drive tray LED is on, a 
component within the drive tray needs 
attention.
On – The Controller canister, the 
power-fan canister, or the drive needs 
attention.
Off – The Controller canister, the 
power-fan canister, and the drive are 
operating normally.
Note: The drive has an LED, but no 

symbol.

AC Power • Controller canister
• Power-fan canister

On – AC power is present.
Off – AC power is not present.

DC Power • Power-fan canister On – Regulated DC power from the 
power-fan canister is present.
Off – Regulated DC power from the 
power-fan canister is not present.

LED Icon Location General Behavior
StorNext M660 Metadata Appliance  Hardware Guide 31



Chapter 2: Hardware Overview
StorNext M660 Components
StorNext M660 
Metadata Expansion 
Unit

The StorNext M660 Metadata Expansion Unit adds an additional 
Metadata Storage Array to the M660 system that features a fully 
populated 24-drive 2U storage enclosure. The first two drives are global 
hot spares. The next six are configured into three 1+1 RAID-1 mirrors. 
These mirrored sets are split into two stripe groups (SGs): SG0 combines 
three 12-GB LUNs into the metadata and journal for the shared file 
system. SG1 combines three 888-GB LUNs into the shared HA file 
system. The Metadata Expansion Unit includes the StorNext Storage 
Manager database.

The Expansion Unit is supplied with dual Snowmass controllers. Each 
controller provides two 6Gb Serial Attached SCSI (SAS) host ports with 2 
GB of system cache. The HDDs and SSDs are supplied in hot-swappable 
drive carriers that fit in the drive bays.

The Expansion Unit consists of the following:

• Metadata Expansion Unit – Front View

• Metadata Expansion Unit – Rear View on page 33

Link Service 
Action 
Required 
(Fault)

• Controller canister On – The cable is attached, and at least 
one lane has a link-up status, but one 
lane has a link-down status.
Off – The cable is not attached, and all 
lanes have a link-up status, or the cable 
is attached, and all lanes have a link-
down status.

Link Up Two LEDs
above 
each 
expansion 
connector

• Controller canister On – The cable is attached, and at least 
one lane has a link-up status.
Off – The cable is not attached, or the 
cable is attached and all lanes have a 
linkdown status.

LED Icon Location General Behavior
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Metadata Expansion Unit – Front View

The front of the StorNext M660 Metadata Expansion Unit contains the 
left end cap, which contains the drive tray LEDs, the right end cap, and 
the drives (see Figure 13).

Figure 13  StorNext M660 
Metadata Expansion Unit – 
Front View

The StorNext M660 Metadata Expansion Unit has a series of indicators 
and buttons located on the front and back of the array.

Metadata Expansion Unit – Enclosure Tray LEDs

The enclosure LEDs on the front of the unit are identical to those on the 
front of the Metadata Array. To monitor the current status pertaining to 
the enclosure and the components within the enclosure, refer back to 
Metadata Array Canister Locations and Rear Features and Indicators on 
page 38.

Metadata Expansion Unit – Rear View

The  Metadata Expansion Unit contains dual environmental service 
monitor (ESM) canisters for connectivity to the Metadata Array. Each 
ESM features LED indicators and connectors. 

Figure 14 shows the location of the ESMs ans Power-Fan Canisters.

Global
Hot Spares

3 x 1+1
RAID 1

8 x 1+1
RAID 1
StorNext M660 Metadata Appliance  Hardware Guide 33



Chapter 2: Hardware Overview
StorNext M660 Components
Figure 14  Metadata Expansion 
Unit – Rear View

Figure 15 shows the location of LEDs and SAS connectors on the ESM 
Canister.

Figure 15  Metadata Expansion 
Unit Rear Features and 
Indicators - ESM Canister

.

Table 7 describes the ESM connectors, displays, and LEDs. Unlabeled 
connectors are reserved for Quantum Service. 

Table 7  Metadata Expansion 
Unit – Rear Panel Features and 
Indicators

ID/Diag

Port 1

ID/Diag

Port 1

ID/DiagID/DiagID/Diag

P t 1Port 1Port 1

ID/Diagg

P t 1Port 1Port 1

ID/Diag

Port 1

Item Description

1 Host Link 1 Fault LED

2 Host Link 2 Fault LED

3 SAS IN Connector
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Metadata Expansion Unit — General LED Behavior

The drive enclosure is the same type as the Metadata Array. For more 
information about the Metadata Expansion Unit LED locations and 
general behavior, refer back to Metadata Array — General LED Behavior 
on page 30.

StorNext M660 Connectivity

This section covers:

• StorNext M660 Power Cabling

• StorNext M660 SAS Cabling

• StorNext M660 SAN Cabling

• StorNext M660 LAN Cabling

• StorNext M662 and M662XL Lattus Cabing

4 SAS IN Connector

5 ESM Expansion Fault LED

6 ESM Expansion Active LED

7 SAS Expansion Connector

8 Controller A Service Action Allowed LED

9 Controller A Service Action Required LED

10 Cache Active LED

11 Seven-Segment Displays

Item Description
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StorNext M660 Power 
Cabling

Connect the power cables for each component into an available power 
outlet (see Figure 16 on page 37).

Note: Quantum recommends attaching the primary and secondary 
power connections to alternate power sources for resiliency. 
Quantum also recommends that one of these power sources be 
an uninterruptible power source, such as battery backup or 
generator, or be connected to redundant AC power supplies to 
avoid system interruption in the case of a power failure.
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Figure 16  StorNext M660 
Power Connections

StorNext M660 SAS 
Cabling

Connect the Serial Attached SCSI (SAS) ports cables between the nodes 
and the Metadata Array as shown in Figure 19. SAS connectivity 

Port 1 Port 2

ID/Diag

Lnk Lnk Port 1 Port 2

ID/Diag
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Port 1
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between the Expansion Unit and the Metadata Array only occurs when 
installing an Expansion Unit.

Note:

Note: To make it easier to connect the cables, release the sliding rails 
and slide the MDC nodes out the front of the rack so that the 
rear of the MDC nodes is flush with the rear of the Metadata 
Array and the Expansion Unit (if used).

Note: There are two generations of Metadata Array controller 
currently in use. While both generations of the controller use 
the same SAS connection order, from left to right, different 
cables are used for the connections. The Tahoe controller is 
connected with a cable containing both a 12Gb SAS (square) 
connection, which is attached to the Tahoe controller, and a 
6Gb SAS (rectangular) connection, which is attached to the 
MDC nodes and the Expansion Unit (if used). The previous 
generation Snowmass Controller cable contains 6Gb 
connections on both ends. Use the appropriate SAS cables for 
the controllers in your Metadata Array.
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Figure 17  StorNext M660 SAS 
Cabling - Tahoe Controller with 
Expansion Unit

Port 1 Port 2

ID/
Diag

|O|O| Port 1 Port 2

ID/
Diag

|O|O|

ID/Diag

Port 1

ID/Diag

Port 1

Metadata Array - Rear

MDC Node #2 - Rear

Expansion Unit - Rear

MDC Node #1 - Rear

EXP EXP
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Figure 18  StorNext M660 SAS 
Cabling - Tahoe Controller - 
Without Expansion Unit

Port 1 Port 2

ID/
Diag

|O|O| Port 1 Port 2

ID/
Diag

|O|O|

Metadata Array - Rear

MDC Node #2 - Rear

MDC Node #1 - Rear
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Figure 19  StorNext M660 SAS 
Cabling - Snowmass Controller 
with Expansion Unit

Port 1 Port 2

ID/Diag

Lnk Lnk Port 1 Port 2

ID/Diag

Lnk Lnk

ID/Diag

Port 1

ID/Diag

Port 1

Metadata Array - Rear

MDC Node #2 - Rear

Expansion Unit - Rear

MDC Node #1 - Rear
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Figure 20  StorNext M660 SAS 
Cabling - Snowmass Controller 
- Without Expansion Unit

StorNext M660 LAN 
Cabling

The number of customer-facing network ports depends on the model 
type. Each MDC node also contains an iDRAC port and a dedicated 
service port. By default, each StorNext M660 model ships with two 
bonded network interfaces: Bond 0 and Bond 1. The number of 
customer-facing network ports and port speeds depends on the M660 
model. All ports, excluding the service and iDRAC ports, are customer-

Port 1 Port 2

ID/Diag

Lnk Lnk Port 1 Port 2

D/Diag

Lnk Lnk

Metadata Array - rear

MDC Node  2 - rear

MDC Node 1 - rear
42 StorNext M660 Metadata Appliance  Hardware Guide



Chapter 2: Hardware Overview
StorNext M660 Connectivity
configurable. Instructions for changing the default configuration are 
located in the “Step 3: System” section of the latest version of the 
StorNext User’s Guide.

The default M661 and M661XL network interface configuration is as 
follows:

• Two interfaces, Eth2 and Eth3, are bonded together by default into 
bond0 for the Metadata network. This bond can be broken in the 
GUI and the Service menu. When not bonded, Eth2 will be 
configured as a standalone port, and Eth3 will be de-configured and 
not used by the system.

• Two interfaces, Eth1 and Eth4, are bonded together into bond1 for 
GUI/management. This bond can be broken in the GUI and the 
Service Menu. When not bonded, Eth1 will be configured as a 
standalone port and Eth4 will be de-configured and not used by the 
system. 

• The remaining seven ports can be configured through the GUI in 
various combinations and bonds for gateway port access.

Figure 21 shows the 11 1GbE customer-facing Ethernet ports on the 
StorNext M661 and M661XL.

Figure 21  StorNext M661 and 
M661XL Network Ports

Table 8 identifies the logical port configuration, port function and 
default bonding for the StorNext M661 and M661XL.
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Table 8  StorNext M661 and 
M661XL Network 
Configuration

The default StorNext M662 and M662XL network interface 
configuration is as follows:

• Two interfaces, Eth2 and Eth3, bonded together into bond0 for the 
Metadata network. This bond can be broken in the GUI and the 
service menu. When not bonded, Eth2 will be configured as a 
standalone port and Eth3 will be de-configured and not used by the 
system.

• Two interfaces, Eth1 and Eth4, are bonded together into bond1 for 
GUI/management. This bond can be broken in the GUI and the 
service menu. When not bonded, Eth1 will be configured as a 
standalone port and Eth4 will be de-configured and not used by the 
system. 

• The remaining five ports can be configured through the GUI in 
various combinations and bonds for gateway port access.

Ethernet 
Port 

Number

Logical 
Ethernet 

Port Number
Physical Port 

Location Port Function Bond

D N/A iDRAC Port
Service N/A

S eth0 Integrated Port 1
1 eth1 Integrated Port 2 GUI and Management

(Configurable from Service Menu)
Bond 1

When not bonded, eth1 is usable 
and eth4 is not usable

2 eth2 Integrated Port 3
Metadata 

(Configurable from 
Service Menu)

When not bonded, eth2 is usable 
and eth3 is not usable

3 eth3 Integrated Port 4 Bond 0
When not bonded, eth3 is not used

4 eth4 Slot 2, Port 1 GUI and Management
(Configurable from Service Menu)

Bond 1
When not bonded, eth4 is not used

5 eth5 Slot 2, Port 2

Gateway User Configurable from GUI

6 eth6 Slot 2, Port 3
7 eth7 Slot 2, Port 4
8 eth8 Slot 1, Port 1
9 eth9 Slot 1, Port 2

10 eth10 Slot 1, Port 3
11 eth11 Slot 1, Port 4
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Figure 22 shows the two 10GbE and seven 1GbE customer-facing 
Ethernet ports on the StorNext M662 and M662XL.

Figure 22  StorNext M662 and 
M662XL Network Ports

Table 9 identifies the logical port configuration, port function and 
default bonding for the StorNext M662 and M662XL.
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Table 9  StorNext M662 and 
M662XL Network 
Configuration

StorNext M660 SAN 
Cabling

Each StorNext M660 MDC node contains one 4-port 8Gb Fibre Channel 
(FC) host bus adapter (HBA) card in PCIe expansion slot 3.

Note: If small form-factor pluggable (SFP) FC adapters are needed, 
use only Intel-based SFP adapters. SFP adapters from other 
vendors are not compatible with the FC HBA card used in the 
StorNext M660. Twinax cables have the adapters built into the 
end of the cable, so they do not require SFP adapters.

Fibre Channel Zoning

Each Fibre Channel port supports dual-port tape drives and libraries. 
StorNext clients should not be zoned to access the tape drives/libraries 
unless they are acting as a Distributed Data Mover host.

Ethernet 
Port 

Number

Logical 
Ethernet 

Port Number
Physical Port 

Location Port Function Bond

D N/A iDRAC Port
Service N/A

S eth0 Integrated Port 1
1 eth1 Integrated Port 2 GUI and Management

(Configurable from Service Menu)
Bond 1

When not bonded, eth1 is usable 
and eth4 is not usable

2 eth2 Integrated Port 3
Metadata 

(Configurable from 
Service Menu)

When not bonded, eth2 is usable 
and eth3 is not usable

3 eth3 Integrated Port 4 Bond 0
When not bonded, eth3 is not used

4 eth4 Slot 2, Port 1 GUI and Management
(Configurable from Service Menu)

Bond 1
When not bonded, eth4 is not used

5 eth5 Slot 2, Port 2

Gateway User Configurable from GUI

6 eth6 Slot 2, Port 3
7 eth7 Slot 2, Port 4
8 eth8 Slot 1, Port 1 

(10 GbE)
9 eth9 Slot 1, Port 2 

(10 GbE)
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Separate Fibre Channel zoning is required for tape and disk. If the 
system has a tape library, use FC ports 1 and 2 for disk, and FC ports 3 
and 4 for tape . The actual zoning configuration for these devices is 
dependent on variables such as the Fibre Channel switch vendor, the 
WWPN of the HBA ports, and the external hardware.

Connect the FC host ports to your SAN as shown in Figure 23 on 
page 47.

Figure 23  StorNext M660 SAN 
Cabling
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StorNext M662 and 
M662XL Lattus Cabing

Interconnect switches are used to connect the components within a 
Lattus system, and are also used to connect the M662 and M662XL to 
the Lattus system. Two different interconnect configurations are 
currently supported, a configuration with a single interconnect switch 
(Figure 24), and another configuration with two interconnect switches 
for redundancy (Figure 25 on page 50).

Connecting the M662 and M662XL to the Lattus system involves cabling 
Eth8 and Eth9 10GbE ports on both MDC Nodes to the Lattus 
interconnect switch.

Note: Connect to the Lattus system only after both the Lattus system 
installation and configuration is complete, and the M662 or 
M662XL installation is complete, and the ethernet ports have 
been configured in the StorNext GUI.

Note: You must first configure Eth8 and Eth9 ports on the rear of the 
M662 or M662XL prior to cabling the M662 to the Lattus 
interconnect switch(es).
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Figure 24  StorNext M662 and 
M662XL Single Lattus 
Interconnect Switch Cabling

Lattus Interconnect Switch - Front

M662 Node #2 - Rear

M662 Node #1 - Rear
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Figure 25  StorNext M662 and 
M662XL Redundant Lattus 
Interconnect Switches Cabling

Lattus Interconnect Switch #2 - Front

Lattus Interconnect Switch #1 - Front

M662 Node #2 - Rear

M662 Node #1 - Rear
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Relocating the StorNext M660 System

If you ever need to relocate the StorNext M660 system to a different 
location, please contact Quantum Customer Support for additional 
information. The StorNext M660 system must be relocated by a 
qualified Quantum field service engineer.
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Chapter 3
Basic System Operations

This chapter is divided into the following sections:

• Powering On All StorNext M660 System Components on page 54

• Shutting Down All StorNext M660 System Components on page 57

• Powering On a Single MDC Node of the StorNext M660 on page 58

• Shutting Down a Single MDC Node of the StorNext M660 on 
page 59

• System Serial Numbers and Service Tag on page 60

• Before Upgrading Firmware on page 62

• Upgrading Firmware on page 63

• Converting to HA on page 71

• Additional Common Operations on page 76, which includes the 
following:

• Changing the MDC VIP Address on page 76

• StorNext Operations on page 78
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Powering On All StorNext M660 System Components

Figure 26 on page 56 illustrates the location of the power switches, and 
the specific order to follow when powering on the StorNext M660 
system components.

Note: Before continuing, verify that all power switches on every 
component are in the OFF position.

1 Turn on both power switches on the back of the Expansion Unit, if 
used. Call out number 1 in Figure 26 on page 56 shows the location 
of the power switch of the power supply for both Expansion Unit 
power supplies.

Note: Before powering up the Metadata Array, make sure that 
the Expansion Unit drive LEDs are all green, and the seven-
segment display on both Expansion Unit controllers 
indicates “0”. This indicates that the Expansion Unit array is 
ready for I/O. This process takes approximately one to two 
minutes. The system is then ready for powering up the 
Metadata Array.

2 Turn on both power switches on the back of the Metadata Array 
Callout number 2 in Figure 26 on page 56 shows the location of the 
power switch for both Metadata Array power supplies.

Note: Before powering up the MDC Nodes, make sure that the 
Metadata Array drive LEDs are all green, and the seven-
segment LCD displays on both controllers of the Metadata 
Array indicate “85”. This indicates that the Metadata Array 
is ready for I/O. The system is then ready for powering up 
the MDC Nodes.
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The seven-segment LCD displays are located on each controller on the 
back of the array as shown here:

3 Turn on the power switch on the front of each of the MDC Nodes. 
Callout number 3 in Figure 26 on page 56 shows the location of the 
power switches and the power on sequence.

Port 1 P

ID/Diag

Lnk Lnk Port 1 P

ID/Diag

Lnk LnkPort 2 Port 2

Metadata Array - rear
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Figure 26  StorNext M660 
Power-On Sequence
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Shutting Down All StorNext M660 System 
Components

To cleanly shut down the StorNext M660 Operating System and 
software and power off the hardware:

1 Halt all I/O access to SAN and/or LAN clients.

2 For each SAN and/or LAN client, unmount and/or unshare the file 
systems. Refer to that client’s operating system administrator’s 
guide for instructions.

3 Open an ssh connection to the MDC node currently acting as the 
secondary node, and log in as the stornext user.

4 To log in to the MDC node currently acting as the secondary node 
enter:

• User: stornext

• Password: enter the customer-supplied password (the default 
password is password)

5 Enter sudo rootsh.

6 Enter the password for the stornext user account a second time.

7 Enter /sbin/poweroff. Both the operating system and the StorNext 
software are gracefully shut down, and then the system powers off. 

8 Open an ssh connection to the MDC node currently acting as the 
primary node.

9 To login to the MDC node currently acting as the primary node 
enter:

• User: stornext

• Password: enter the customer-supplied password (the default 
password is password)

10 Enter sudo rootsh.

11 Enter the password for the stornext user account a second time.

12 Enter /sbin/poweroff. Both the operating system and the StorNext 
software are gracefully shut down, and then the system will powers 
off.
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13 Turn off the Metadata Array module power switches.

Powering On a Single MDC Node of the StorNext 
M660

To turn on power to the system:

1 Push the power switch on the front of the MDC node you wish to 
power on (see Figure 27 on page 58).

Figure 27  Turning On Single 
MDC Node Power

2 If you are powering on MDC Node 1, and MDC Node 2 is currently 
operating as the primary, perform a system failover after MDC Node 
1 comes back online (see Initiating a Graceful System Failover on 
page 74), if desired, to set MDC Node 1 to act as the primary node.

3 On each LAN client, mount the file systems on clients.

4 Restart I/O access to all LAN clients.

Front of the System

Power Button
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Shutting Down a Single MDC Node of the StorNext 
M660

To shut down a single MDC node:

1 Open an SSH connection to the MDC node you wish to access using 
either IP address 10.17.21.1 or 10.17.21.2 on the MDC/Metadata  
network.

Note: Use the IP addresses assigned within the network if 
different from the defaults used here.)

2 Enter stornext for the username at the prompt.

3 Enter the stornext password. The default password is “password”, 
but may have been changed after initial configuration.

4 At the command prompt enter the following to gain root user 
access:

5 Enter the password for the stornext user account again when 
prompted.

6 Press Enter.

7 If you are connected to the MDC node currently acting as the 
primary, enter the following (if you are connected to the MDC node 
currently acting as the secondary, issue the command provided in 
Step 11):

8 Wait until the MDC node currently acting as primary becomes the 
secondary, and leave your SSH connection to this node open. (Time 
may vary.)

sudo rootsh

service cvfs fullstop
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9 Open an SSH connection to the MDC node now operating as the 
primary. Confirm that the MDC node is operating as the primary by 
entering the following at the command line:

10 Verify the output is (bold used for clarification):

11 Go to the SSH terminal session for the secondary MDC node (may 
have previously been running as primary), and enter the following:

Note: You will know the system is shut down when your monitor 
goes blank, or you lose your connection with the system.

12 Remove power cables from the MDC node.

Note: For systems running a release of StorNext prior to StorNext 5 
release 5.1, a RAS ticket on systems with open manage prior to 
7.4 may be generated when one of the MDC nodes is powered 
off. This RAS ticket, which indicates a failure of the appliance, is 
incorrect. There is no loss of functionality if one node is shut 
down during the servicing of that node.

System Serial Numbers and Service Tag

The StorNext M660 Metadata Appliance system serial number and the 
service tag number may be needed when contacting Quantum Support.

snhamgr -m status

:default:primary:default:stopped:

/sbin/poweroff
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Locating the System 
Serial Number

The System Serial Number is located in the following locations:

• In a sleeve on the back of each MDC node, the metadata array, and 
the expansion unit.

• Scrolling on the LCD panel on the front of each MDC node.

• From the Service Menu of each MDC node.

• In the title bar and on the Help > About page of the StorNext M660 
Metadata Appliance GUI as shown here:

Figure 28  Locating the System 
Serial Number on the GUI

Serial Number Format
System serial numbers are alpha-numeric (example: CX1234CKD5678).

Locating the Service
Tag Number

The Service Tag Number is located on the service tag, which is located 
on a pullout tray on the front of each MDC Node of the StorNext M660 
Metadata Appliance.
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Before Upgrading Firmware

TSM Indexing Delay for 
Large Databases

A database index named classndxatimeme will be automatically 
added to the tmdb.tier000files% and tmdb.tier001files% tables upon 
starting TSM for the first time after upgrading to specific StorNext 5 
releases.

StorNext 5 Releases affected: 5.0.1, 5.1, and 5.1.1

Upgrading from: 4.3.2, 4.3.3, 4.7.0, 4.7.0.1, 4.7.1, 4.7.2, and the initial 
release of StorNext 5.

Note: This does not apply to direct upgrades from StorNext 5 Release 
5.0.1 to StorNext 5 Release 5.1 or later. So do not use the script 
below for these upgrades.

This index improves the performance of certain operations such as 
truncation policies. However, the creation of this index can take multiple 
hours for very large databases. TSM will be unavailable after upgrading 
until the indexing has completed.

Running the Script To minimize TSM downtime after upgrade, the classndxatimeme index 
can be created prior to performing the upgrade using the 
index_tierfiles.pl script availablefrom the StorNext Metadata 
Appliances page on CSWeb. The script can be run while TSM is running, 
although it may impact the performance of other operations while the 
index is being added to the database.

Caution: The following script should only be executed against 
StorNext release as indicated in the previous section.

To manually add the index:

1 Download the index_tierfiles.pl file from CSWeb.

2 Login to the primary MDC, and access the command line of the 
system.

• User: stornext

• Password: (enter the password for the stornext account)
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3 Type sudo rootsh to gain root user access.
4 Enter the password a second time.

5 Copy the index_tierfiles.pl file downloaded from CSWeb to
the /tmp directory on the primary MDC node.

6 Source the profile:

. /usr/adic/.profile
7 Verify that the database is up by running:

mysql_control start
8 Execute:

/tmp/index_tierfiles.pl

Upgrading Firmware

The Firmware Upgrade option allows you to perform a firmware 
upgrade on StorNext M660 Metadata Appliances. Upgrading the 
firmware also upgrades StorNext, if applicable.

Note: Use the StorNext M660 Metadata Appliance GUI to perform all 
firmware upgrades and HA conversions.

Upgrade 
Considerations

Before you begin the upgrade you should note the following 
considerations so you can plan accordingly:

Consider the following prior to upgrading the M660 Metadata 
Appliance:

• Not all StorNext releases may be upgraded to a given StorNext 
release. As a result, an upgrade to the current version of StorNext 
may require multiple, incremental upgrades, depending on the 
version of StorNext currently installed on the StorNext M660.

For information about supported upgrade paths for StorNext, 
consult the StorNext Compatibility Guide. If your system is running a 
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StorNext release prior to the supported upgrade releases for a given 
StorNext release, consult an earlier version of the StorNext 
Compatibility Guide that applies to your specific upgrade, and the 
dependencies for StorNext Clients in the environment.

• Firmware upgrade installation files must first be acquired from 
Quantum.

Obtain the Firmware 
Upgrade Files

To obtain the firmware files (both are required) you wish to install 
for the Metadata Appliance:

Note: The two files are large - around 2 GB total, so plan time to 
download the files for the upgrade.

a Go to the CSWeb site and log in.

b Navigate to the StorNext Products page for your appliance (on 
the lefthand side of the CSWeb site, look for the appropriate 
link under the StorNext Products section).

The first section of the page contains Downloads for the given 
appliance.

c Scroll down to the Current Software section, and download 
both firmware image files.

• Firmware upgrade installation files, which contain the .fw suffix, 
must be uploaded to the system prior to beginning the upgrade 
process. Uploading the firmware upgrade files in a network with 
low latency should only take a matter of minutes. High network 
latency in your environment can slow the upload of these files onto 
the Metadata Appliance.

• When using the firmware upgrade process from the StorNext GUI, 
the license for the system will be automatically applied to the 
StorNext M660.
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Firmware Upgrade 
Process and Time 
Estimates

There are several factors that affect the availability of the system and 
metadata operations during upgrades. StorNext appliance firmware 
upgrades (contained in the .fw file downloaded earlier in this process) 
always include an update to the StorNext software in the release, and 
can also includes updates to MDC node firmware and metadata array 
firmware. The way in which these updates are applied and the impacts 
to system availability vary, depending on which firmware upgrade being 
applied, as described here:

StorNext Releases/Downtime Requirements

Note: Metadata array operations and the StorNext file system are 
unavailable while metadata firmware is installed. We refer to 
suspension of metadata operation as a downtime upgrade, 
since no array I/O may take place during this time.

Note: The upgrade of metadata appliance firmware also, once 
installed, initiates a reboot of both MDC nodes prior to 5.1.1, 
requiring additional time. Plan upgrade times accordingly.

StorNext Releases requiring suspension of metadata operations during 
upgrades occur any time a newer release contains a newer metadata 
array firmware version than the version currently installed on the 
appliance.

The following table contains examples of firmware upgrade versions. 
Upgrading StorNext Release with a newer firmware will be a downtime 
upgrade:

StorNext Release* Array Firmware Version

5.1.1 08.10.13

5.1 07.84.46

5.0.1 07.84.46

5 07.84.46

4.7.1 07.84.46
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Example (based on the previous table): If you were upgrading the 
StorNext firmware from 4.6.1 to StorNext 5 Release 5.1.1, the array 
firmware would be upgraded from 07.80.55 to 08.10.13. This is a 
downtime upgrade.

4.7.0.1 07.84.46

4.7.0 07.84.46

4.6.1 07.80.55

4.6 07.80.55

4.3.3 07.80.55

4.3.2 07.80.55

4.3.1 07.80.55

4.3.0 07.80.55

4.2.2.0.1 07.75.17

* Note: Some StorNext releases are not supported upgrade paths to 
StorNext 5 releases. Please consult the StorNext 5 Compatibility 
Guides and/or older StorNext Compatibility Guides applicable for the 
StorNext Release you wish to upgrade to, in order to determine 
upgrade availability.

StorNext Release* Array Firmware Version
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Components and Upgrade Time Estimates

For All Firmware Upgrades

• Full access to all GUI features are not available during the upgrade. 
The GUI should not be started until the upgrade is complete.

For StorNext 5 and Later Upgrades

• The upgrade is applied to each node in reverse order, beginning 
with the secondary node. When the secondary node has completed 
its upgrade, the system will failover from the primary to the 
secondary, and begin upgrading the primary system. While the node 
firmware upgrade is being applied, metadata operations are not 
interrupted. Access to a limited StorNext GUI is available on the 
MDC node acting as primary during the upgrade of the node acting 
as secondary.

• Both MDC nodes will need to reboot after the metadata array 
firmware update is applied.

Note: As of StorNext 5 Release 5.1.1, MDC node reboots after 
metadata array firmware updates are no longer required.

For Upgrades Prior to StorNext 5

• Each StorNext firmware update requires a reboot of both nodes. In 
some cases, multiple reboots of the nodes are required.

Component Upgrade Time Estimate (approx. minimum)

MDC node 30 to 60 minutes per node*

Metadata Array 20 minutes**

* Reboot times could vary widely, depending on the size of the SAN in 
your environment, whether or not MDC node firmware needs to be 
upgraded, and the StorNext Release installed prior to the upgrade.
** Since metadata array operations, and the StorNext file system will 
be suspended during the array firmware upgrade, this is a downtime 
upgrade.
Note: See sections below for information on additional reboots that 

may be required for specific StorNext Releases.
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• Each time the firmware update is done, the secondary node of the 
Metadata Appliance is left out of the HA configuration. As a result, 
you will need to convert the StorNext M660 to an HA system after 
each upgrade in order to regain failover operations. After the HA 
conversion, both nodes will reboot, which can take 30 minutes or 
longer per node.

• The Storage Manager components will need to be restarted after 
the HA conversion is complete by clicking the Start button in the 
Storage Manager panel of the Tools > System Control page.

• All upgrades prior to StorNext 5 are downtime upgrades.

Upgrade Procedure To upgrade the StorNext M660:

1 Download the required firmware file(s) from Quantum CSWeb for 
the StorNext release needed.

2 Log into the StorNext GUI.

3 Choose Tools > Firmware Upgrade.

The Firmware Upgrade page appears.

Figure 29  Firmware Upgrade 
Page

4 Do one of the following:

a Select Auto Upload to upload the file immediately after you 
select it.

b Do not select Auto Upload.
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5 Click Browse..., and then navigate to the directory where the file 
resides. Firmware files are identifiable by the .fw extension.

Note: There are two .fw files required for updating firmware. The 
filenames are similar to QTM-DXiSNA-upd-5.1.0.OS6-
15147-15110.1of2.fw and QTM-DXiSNA-upd-5.1.0.OS6-
15147-15110.2of2.fw. Since it is a two-part upgrade, 
upload both files to the GUI. To begin activation of the 
upgrade, select either of the uploaded files and then click 
Apply. Both parts are applied to the system.

If you selected the Auto Upload option, the file is immediately 
uploaded. Proceed to Step 7.

6 If you did not select the Auto Upload option and want to validate 
the file before uploading, click Validate. After a message informs 
you that the file is valid, click the Upload button located to the right 
of the Browse... button.

Note: Files are automatically validated after you click Apply (Step 7), 
but you won’t receive a message telling you the file is valid. 

7 Click Apply to begin the upgrade.

The green status indicator at the top of the page indicates upload 
progress, not the upgrade progress. To monitor upgrade progress, 
check the logs available under the Reports menu.

If Upgrading to StorNext 5 from StorNext 4.7.0:

The upgrade process is complete. There is no interruption of metadata 
operations during or after the upgrade.

If Upgrading to StorNext 5 from StorNext Releases Prior to StorNext 
4.7.0:

Note: After the upgrade to the primary MDC node completes, 
metadata operations will be interrupted for 30 minutes or 
more, and both MDC nodes will reboot, which could take an 
additional 30 minutes to complete, before you are able to log 
back in, so plan upgrade times accordingly.
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If Upgrading to StorNext Releases Prior to StorNext 5:

Note: After the upgrade to the primary MDC node completes, 
metadata operations will be interrupted for 30 minutes or 
more, and both MDC nodes will reboot, which could take an 
additional 30 minutes to complete. It could be a long time 
before you are able to log back in, so plan upgrade times 
accordingly.

8 Convert the system to HA, according to Converting to HA on 
page 71. (Not necessary when upgrading to StorNext 5).

GUI Feedback During Upgrades

There are some indications within the GUI that the system is being 
upgraded. Here are some notes about this visual feedback:

If Upgrading to StorNext 5 from StorNext 4.7.0:

• For systems without a defined virtual IP, the secondary MDC nodes is 
upgraded first, followed by a fail over to the secondary MDC node, 
which takes the role of the primary MDC node. The GUI will run on 
the primary MDC node until the secondary MDC node completes its 
upgrade, and the system fails over to the secondary MDC node. At 
that point you will need to bring up the GUI for the secondary MDC 
node, while the primary MDC node completes its upgrade. At the 
end of updating the primary MDC node, the system will not 
automatically fail over again, it only fails over once.

• If a virtual IP is used, the GUI will need to be refreshed to display the 
GUI once the secondary MDC node upgrade and failover is 
complete. The assumes the role of the primary when the failover 
occurs. Once the original primary MDC node completes its upgrade, 
it will assume the role of the secondary MDC node.

If Upgrading to StorNext Releases Prior to StorNext 5:

• On the primary MDC node, the GUI will display different status 
messages throughout the installation, including messages that the 
system will reboot, and red icons indicating that the primary MDC 
node, secondary MDC node, File System, and Storage Manager are 
also disabled.
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• The current user account will eventually time out and the GUI will 
stop functioning when the power to Metadata Appliance is 
removed during reboot. Status updates will cease and the GUI will 
not be fully-functional again until the system completes rebooting 
both MDC nodes.

Post-Upgrade Failover

If you desire to failover your system after the upgrade, see Initiating a 
Graceful System Failover on page 74.

Deleting Uploaded Files Follow these steps to delete uploaded files you no longer need:

1 Log into the StorNext GUI.

2 Choose Tools > Firmware Upgrade.

3 The Firmware Upgrade page appears

4 Select from the list the file you want to delete, and then click 
Delete. (If you want to delete multiple files, you must delete them 
one at a time.)

5 When a confirmation appears, click Yes to proceed or No to abort. 

When a message informs you that the file was successfully deleted, click 
OK.

Converting to HA

Note: If you are upgrading to StorNext 5 or later from StorNext 4.7 or 
later, and have previously converted your system to HA 
configuration, the conversion process is unnecessary. 
Previously-converted systems will not be taken out of HA 
configuration, so the option to convert to HA is unavailable. 
However, for StorNext releases prior to 4.7, an HA conversion is 
necessary after StorNext software upgrades.
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Please note the following:

• The UIDs for the quantumdb and tdlm users and the adic group 
must be identical on both MDC nodes of an HA pair. If the UIDs are 
not identical, the MySQL database will not start (due to file 
permission errors), which in turn prevents storage manager from 
fully starting up.

Follow these steps to configure HA:

1 From the StorNext GUI on MDC Node 1, choose Tools > High 
Availability > Convert.

Figure 30  Tools > HA > 
Convert 

Caution: On the Tools > High Availability page, it is critical that 
you assign the Metadata network IP address in the 
MDC Address field and NOT the Management network 
IP address.
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Caution: Double-check that the Shared File System option is set 
to the shared file system on the metadata array for the 
metadata appliance/HA pair and NO OTHER shared file 
system on the list before applying changes. The file 
system selection on this page may only be done once, 
so make sure you select the shared file system on the 
metadata array.

Note: A virtual IP (VIP) may also be set at this time. The VIP 
should be added to management IP, not the metadata IP.

2 Click Convert to convert MDC Node 1 (primary) to HA.

Note: The primary MDC node Status displays “Converted”.

3 The IP address of the secondary MDC node of the StorNext M660 
will appear in the System Name field along with a port number.

4 Click Scan Host. The system should resolve the secondary MDC 
node - the MDC Address will auto-fill with a value.

5 Click Convert to convert the secondary MDC node.

Note: Both MDC nodes will reboot, which can take 30 minutes or 
more per node to complete.

6 Storage Manager may need to be started following the HA 
conversion if the system was in config mode at the time that HA 
conversion was initiated. To restart the Storage Manager 
components, click the Start button in the Storage Manager panel of 
the Tools > System Control page.

GUI Feedback During HA Conversion

There are some indications within the GUI that the system is being 
upgraded. Here are some notes about this visual feedback:

• After the StorNext upgrade has completed, and the HA 
configuration has been done, the GUI for the secondary MDC node 
provides a message stating it is not the primary MDC node and a 
link to launch the primary MDC node.
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Caution: Do not login to the GUI of the secondary MDC node at any 
point during the upgrade/HA conversion process. System 
configuration and licensing for the system could be 
compromised. 

• When you are able to log into the primary /node, after accepting the 
EULA, the system will automatically display the Tools > System 
Control page. Click the Start button to restart the Storage Manager 
components.

• Wait until the system icons for both MDC nodes of the system as 
well as File System and Storage Manager are green, which indicates 
normal operation.

Post-Conversion Steps

If you are using the DDM feature, do the following:

• If you use the secondary MDC node as a DDM mover, make sure the 
file systems are mounted.

Initiating a Graceful System Failover

During StorNext 5 release 5.0 or later upgrades, the Metadata Appliance 
fails over once. Because of this single failover, the MDC node originally 
operating as primary is set as the secondary after the upgrade. This 
procedure provides the steps necessary to set the MDC nodes back to 
the system state prior to the upgrade for this scenario.

To initiate the failover of a Metadata Appliance after converting to HA or 
any time a failover is desired:

1 Open an SSH connection to the MDC node operating as the 
primary.

2 Login to the command line of the primary MDC node.

• User: stornext

• Password: (the customer should have the password for the 
stornext account)

3 Type sudo rootsh to gain root user access.

4 Enter the password a second time.
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5 Confirm that the MDC node is operating as the primary by entering 
the following at the command line:

6 Verify the output is (bold used for clarification):

7 On the MDC node operating as the primary, initiate an HA failover 
to the MDC node operating as the secondary.

8 Wait until the secondary MDC node becomes the primary, and 
leave your SSH connection to this node open. (Time may vary.)

9 Open an SSH connection to the MDC node now operating as the 
primary.

10 Login to the command line of the primary MDC node.

• User: stornext

• Password: (the customer should have the password for the 
stornext account)

11 Type sudo rootsh to gain root user access.

12 Enter the password a second time.

13 Confirm that the MDC node is operating as the primary by entering 
the following at the command line:

14 Verify the output is:

snhamgr -m status

:default:primary:default:running:

service cvfs stop

snhamgr -m status

:default:primary:default:stopped:
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15 From the SSH connection to the MDC node now operating as the 
secondary, enter the following:

16 Confirm that the MDC node is operating as the secondary by 
entering the following at the command line:

17 Verify the output is:

18 Repeat if desired to fail over to the original system operating as the 
primary.

19 Verify that all clients have full access.

20 Test access to all file systems.

Additional Common Operations

Changing the MDC VIP 
Address

To change the Virtual IP address for the M660, do the following:

service cvfs start

snhamgr -m status

:default:running:default:primary:
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Note: This procedure must be used any time the VIP address needs to 
be changed after initial system configuration.

1 Open an ssh connection to the M660 using the IP for the MDC node 
operating as the primary from either the customer’s LAN client or 
Metadata network.

2 Log on using the stornext credentials. The default password is 
“password”.

3 Type the sudo rootsh command to grant root user privileges after 
entering the password for the stornext user account again when 
prompted.

4 From the command line, update the VIP Address using the following 
command (refer to the vip_control man page or the StorNext Man 
Pages Reference Guide for information on changing the address).

5 To update the firewall rules for the MDC node operating as the 
primary, type the following:

6 Close the ssh connection for the MDC node operating as the 
primary.

7 Open an ssh connection to the M660 using the IP for the MDC node 
operating as the secondary.

8 Log on using the stornext credentials. The default password is 
“password”.

9 Type the sudo rootsh command to grant root user privileges after 
entering the password for the stornext user account again when 
prompted.

10 From the command line, update the VIP Address using the following 
command (refer to the vip_control man page or the StorNext Man 
Pages Reference Guide for information on changing the address).

vip_control

/opt/DXi/scripts/netcfg.sh --reset_snvip
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11 To update the firewall rules for the MDC node operating as the 
primary, type the following:

StorNext Operations For more information on performing advanced StorNext operations, 
refer to the following within this document or by accessing documents 
from the StorNext M660 GUI:

• For information on how to monitor the hardware components for 
both MDC nodes, refer to the “The Hardware Status Report” section 
of the latest version of the StorNext User’s Guide.

• For instructions on how to capture system state logs and support 
bundles, refer to the “The Capture State Function” section of the 
latest version of the StorNext User’s Guide.

• For instructions on how to capture DSET logs, refer to the “Capture 
DSET” section of the latest version of the StorNext User’s Guide.

• For information on changing the network configuration, refer to the 
“Step 3: System” section of the latest version of the StorNext User’s 
Guide.

• For information on setting up the distributed data mover (DDM) 
feature, refer to “Distributed Data Mover (DDM)” section of the 
latest version of the StorNext User’s Guide.

• For information on StorNext Advanced Reporting, refer to the 
StorNext Advanced Reporting User’s Guide.

The StorNext User’s Guide also contains chapters such as these, which 
you will find useful:

• StorNext File System Tasks

• StorNext Storage Manager Tasks

• StorNext Reports

• Service Menu Functions

vip_control

/opt/DXi/scripts/netcfg.sh --reset_snvip
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Contacting Quantum

More information about StorNext is available on the Quantum Service 
and Support website at http://www.quantum.com/ServiceandSupport. 
The Quantum Service and Support website contains a collection of 
information, including answers to frequently asked questions (FAQs). 

To request a software upgrade, visit http://www.quantum.com/
ServiceandSupport/Upgrade/Index.aspx. For further assistance, or if 
training is desired, contact the Quantum Technical Assistance Center.

Contacts Quantum company contacts are listed below.

Quantum Home Page

Visit the Quantum home page at: 

http://www.quantum.com

Comments To provide comments or feedback about this document, or about other 
Quantum technical publications, send e-mail to:

doc-comments@quantum.com
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Getting More 
Information or Help

StorageCare™, Quantum’s comprehensive service approach, leverages 
advanced data access and diagnostics technologies with cross-
environment, multi-vendor expertise to resolve backup issues faster and 
at lower cost. 

Accelerate service issue resolution with these exclusive Quantum 
StorageCare services:

• Service and Support Website - Register products, license software, 
browse Quantum Learning courses, check backup software and 
operating system support, and locate manuals, FAQs, firmware 
downloads, product updates and more in one convenient location. 
Benefit today at:

 http://www.quantum.com/ServiceandSupport/Index.aspx

• eSupport - Submit online service requests, update contact 
information, add attachments, and receive status updates via email. 
Online Service accounts are free from Quantum. That account can 
also be used to access Quantum’s Knowledge Base, a 
comprehensive repository of product support information. Sign up 
today at:

http://www.quantum.com/osr

For further assistance, or if training is desired, contact the Quantum 
Customer Support Center:

Worldwide End-User 
Product Warranty

For more information on the Quantum Worldwide End-User Standard 
Limited Product Warranty:

United States 1-800-284-5101 (toll free)
+1-720-249-5700

EMEA +800-7826-8888 (toll free)
+49-6131-3241-1164

APAC +800-7826-8887 (toll free)
+603-7953-3010

For worldwide support:
http://www.quantum.com/ServiceandSupport/Index.aspx
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http://www.quantum.com/serviceandsupport/warrantyinformation/
index.aspx
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